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A propos de ce manuel
Présentation

Objectif du document

Le guide de démarrage rapide utilise un exemple d'application pour décrire les différentes étapes afin 
d'installer rapidement, de configurer et de commander le  TeSys U  Avec ce guide de démarrage rapide, 
vous pouvez facilement configurer un réseau de communication Profibus DP, sous réserve que vous 
connaissiez les bases des automates et des logiciels d'application (Unity Pro, Sycon, ...). L'exécution de 
cette tâche ne nécessite pas d'autres documents. 

Pour plus de détails sur les autres fonctionnalités des démarreurs TeSys U, consultez les documents 
associés indiqués ci-dessous.

Document à consulter

Vous pouvez télécharger ces publications et autres informations techniques depuis notre site web à 
l'adresse : www.schneider-electric.com.

Commentaires utilisateur

Envoyez vos commentaires à l'adresse e-mail techpub@schneider-electric.com

Titre de documentation Référence

Module de communication TeSys U LULC07 Profibus DP - Manuel d'utilisation 1672610

Variables de communication TeSys U - Manuel d'utilisation 1744082

Démarreurs TeSys U LUB/LUS - Instruction de service 1629984

Unités de contrôle TeSys U LUCA/LUCB/LUCC/LUCD - Instruction de service AAV40503

Manuel d'utilisation des DFB disponibles pour les systèmes TeSys 1672600

Module de communication TeSys U LULC07 Profibus DP - Guide du débutant 1672611

Module de communication TeSys U LULC07 Profibus DP - Note d'application 1672612
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Présentation

1672606   06/2009
Présentation 
Contenu de ce chapitre

Ce chapitre contient les sujets suivants :

Présentation de l'application

Présentation

L'exemple d'application vous permet de définir les démarreurs directs (Direct On Line - DOL) étape par 
étape, afin de : 
 fournir une protection magnéto-thermique
 commander le moteur et
 obtenir un retour du contacteur et un retour de déclenchement du disjoncteur.

Description de l'application

 Moteur 1 (M1) :
moteur triphasé, classe 10, 5,5 kW (7,5 hp) à 440 V, 50 Hz, intensité nominale = 10,5 A, démarrage 
direct 

 Moteur 2 (M2) :
moteur triphasé, classe 20, 7,5 kW (10 hp) à 440 V, 50 Hz, intensité nominale = 14,7 A, démarrage 
direct avec contrôle à distance de la charge du moteur.

Solution traditionnelle

Le schéma ci-dessous illustre le câblage utilisé dans la solution traditionnelle : toutes les informations de 
commande et de retour sont câblées à travers un automate.

Sujet Page

Présentation de l'application 5
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Présentation
Solution Schneider Electric avec démarreur Tesys U

Schémas d'alimentation et de commande dans la solution Schneider Electric

Unités de contrôle utilisées dans la solution Schneider Electric

La solution Schneider Electric présentée dans ce guide de démarrage rapide utilise le TeSys U pour 
répondre aux différents besoins des clients.

 LUCA12BL est une unité de contrôle standard utilisée avec le moteur 1 pour les besoins de base :
 commande à distance un moteur (démarrage/arrêt)
 fournit les informations d'état (prêt, en marche, défaut)

 LUCD18BL est une unité de contrôle avancée utilisée avec le moteur 2 pour les besoins avancés, en 
plus des besoins standards :
 alarme
 réarmement automatique et à distance par le bus
 indication de la charge moteur
 différenciation des défauts

Schéma d'alimentation Schéma de commande

1. Coupleur principal TSX PBY 100 Profibus DP 
comprenant une carte PCMCIA, un câble et une 
dérivation
2. Répartiteur LU9GC7 doté de 2 connecteurs 
sub-D 9 broches (connexion du bus au module LULC07 
module) et de bornes à vis (24 V)
3. Raccordement de bobine précâblée LU9BN11L

A
1

A
2

LUCAppBL

5.5 kW

Q1
KM1

M1

440 V 50 Hz

TeSys U TeSys U

A
1

A
2

A
1

A
2

A
1

A
2

LUCDppBL

LULC07

Profibus DP
bus
24 Vdc

Profibus DP
bus
24 Vdc

LULC07

7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

LU9GC7

IN OUT

24V DC

Modicon TSX

Interface 1
PROFIBUS
RS485

Interface 2
host

490 NAE 911 00
PROFIBUS-TAP

2

3 3

LUCDppLUCApp

LULC07 LULC07

TeSys UTeSys U
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Présentation
Architecture du système TeSys U

L'architecture suivante décrit les principaux composants du système TeSys U monté sur une plaque :

Légende Référence commerciale Description

1+2+3+4 Automate Premium comprenant 3 modules : alimentation (1), processeur (2) 
et PCMCIA (3) sur un rack (4)

1 TSX PSY 5500M Module d'alimentation Premium

2 TSX P57 354M Processeur Premium

3 TSX PBY 100 Module PCMCIA Premium comprenant :
 un module hôte pour la carte PCMCIA
 une carte PCMCIA Profibus DP avec câble de raccordement intégré de 

0,6 m (2 ft)
 une dérivation 490 NAE 911 00 Profibus avec 1 connecteur femelle 

sub-D 9 broches (gauche) et 1 connecteur mâle sub-D 15 broches (droite)

4 TSX RKY 6 Rack Premium unique (6 positions), permettant l'installation mécanique et 
électrique de tous les modules Premium

5 490 NAD 911 03 (or 04) Connecteur

6 TSX PBSCA100 Câble de 100 m (328 ft), à couper selon la taille du réseau

7 LU9GC7 Répartiteur doté de 2 connecteurs sub-D 9 broches (connexion du bus) et de 
bornes à vis (24 V)

8 LUB12 Base puissance TeSys U

9 LUCA12BL Unité de contrôle standard

10, 13, 
17

LULC07 Module de communication Profibus DP avec bornier enfichable, pour un 
contrôle fil à fil des bornes A1/A2

11 LUB32 Base puissance TeSys U

12 LUCD18BL Unité de contrôle avancée

14 LU9AD7 Connecteur pour chaînage
 Terminaison de ligne du connecteur de l'esclave 1 = Désactivée
 Terminaison de ligne du connecteur de l'esclave 2 = Activée

15 TSX PBS 100 Câble de 100 m (328 ft), à couper selon la taille du réseau

16 LU9BN11L Raccordement de bobine précâblée (en option)

1 2 3 54 6 7 8 119 10

14

15

12

13

17 16
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Présentation
Outils logiciels

Les outils logiciels suivants doivent être utilisés pour définir les applications. Leur utilisation nécessite une 
connaissance de base.

Conditions réseau

Protocole : Profibus DP

Débits en bauds : 1,500 kbps

Adresses :
 1 pour moteur 1 TeSys U
 2 pour moteur 2 TeSys U

Stratégie de repli :

En cas de perte de communication avec l'automate, la stratégie de repli permet d'actionner un moteur de 
différentes façons. Définissez le paramètre 682 sur l'une des valeurs suivantes :

La stratégie de repli adaptée à l'application est :
 Valeur 1 = Figé pour le moteur 1
 Valeur 2 = Arrêt forcé pour le moteur 2

Référence commerciale Logiciel gratuit Description

UNY SPU EFP CD40 – Logiciel de programmation Unity Pro Extra Large V4.0 pour 
automate Premium.

SYCSPULFUCD29M – Logiciel de configuration de réseau Sycon V2.9 pour 
automate Premium (une seule licence d'utilisation). 

– Bibliothèque DFB, 
comprenant Ctrl_pfb_u_ms

Contrôle/Commande cyclique TeSys U pour Profibus DP MS. 
Téléchargez la bibliothèque TeSys U à partir du site Web 
www.schneider-electric.com.

Valeur du paramètre 682 Mode de repli Description

0 Désactivée Aucune stratégie appliquée. Non recommandé.

1 Figé En cas de détection de perte de communication, le moteur 
conservera son statut :
 Si le moteur est en marche, il continuera de tourner.
 Si le moteur est arrêté, il restera dans cet état.

Aucune modification du statut de commande n'est autorisée. Une 
nouvelle commande ne sera prise en compte qu’après un 
réarmement sur perte de communication (703.3)

2 Arrêt forcé 
(valeur par défaut)

Le moteur est forcé de s'arrêter.
Sortie OA1= 0
Sortie OA3 = 0

3 Inchangé Les modifications du statut de commande sont autorisées. Une 
nouvelle commande sera prise en compte même avant un 
réarmement sur perte de communication (703.3)

4 Forcé en marche en 
sens direct

Sortie OA1= 1 (direct) 
Sortie OA3 = 0

5 Forcé en marche en 
sens inverse

Sortie OA1= 0
Sortie OA3 = 1 (sens inverse)
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Configuration du TeSys U

1672606   06/2009
Configuration du TeSysU
Contenu de ce chapitre

Ce chapitre contient les sujets suivants :

Réglages des LUCA12BL et LUCD18BL

Régler le courant sur les unités de contrôle

La figure ci-dessous illustre comment régler le courant sur l'unité de contrôle à l'aide d'un tournevis (ici 
LUCA12BL) :

Valeurs de réglage du courant

Le tableau ci-dessous présente les réglages pour le LUCA12BL (unité standard) et le LUCD18BL (unité 
avancée) :

Sujet Page

Réglages des LUCA12BL et LUCD18BL 9

Connecteurs LULC07 et réglages d'adresse 10

4.00A

LUCA / LUCD

LULC07

5.00A

7.00A

9.00A

12.0A

3.00A

TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Unité de contrôle Moteur Plage de réglage 
du courant

Puissance nominale 
du moteur

Valeur de réglage du courant = 
Courant nominal du moteur

LUCA12BL M1 3..12 A 5,5 kW (7,5 hp) 10,5 A

LUCD18BL M2 4.4..18 A 7,5 kW (10 hp) 14,7 A
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Configuration du TeSys U
Connecteurs LULC07 et réglages d'adresse

Présentation

A l'aide des commutateurs DIP, sous le module de communication LULC07, définissez l'adresse du 
Profibus DP.

1 Connecteur sub-D 9 broches Profibus DP
2 Bornier Entrée/Sortie et 24 V CC
3 Adresse

Adresse

Définissez une adresse de 1 à 127 à l'aide des 7 commutateurs les plus à droite (SW1 à SW7). 
L’adresse 0 (zéro) n’est pas autorisée et constitue une configuration invalide.

Dans l'application, les adresses sont 1 et 2 :

321

LO1LI1LI2
24V c

VP
P24

RxD/TxD-N

M24
RxD/TxD-P CNTR-P

DGND

SW7 SW6 SW5 SW4 SW3 SW2 SW1 Adresse

0 0 0 0 0 0 1 1 (valeur par défaut)

0 0 0 0 0 1 0 2

Adresse 1 pour le moteur 1 TeSys U Adresse 2 pour le moteur 2 TeSys U

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off
10 1672606 06/2009



1672606 06/2009
3

Configuration d'un réseau de communication vers un automate

1672606   06/2009
Configuration d'un réseau de communication 
vers un automate
Présentation

Ce chapitre décrit en détail comment établir une communication vers un automate Premium à l'aide de :
 Unity Pro et
 Sycon.

Contenu de ce chapitre

Ce chapitre contient les sujets suivants :

Sujet Page

3.1 Configuration du TeSys U sur le réseau Profibus DP avec Unity Pro et Sycon 12

3.2. Configuration des DFB avec l'application 19
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Configuration d'un réseau de communication vers un automate
3.1 Configuration du TeSys U sur le réseau Profibus DP avec Unity Pro et Sycon

Processus de configuration d'un automate Premium

1)  Téléchargement des fichiers GSD

Le tableau suivant présente la procédure de téléchargement des fichiers GSD et des fichiers icône 
associés au Tesys U à partir du site Web www.schneider-electric.com :

Étape Action

1 Accédez au site Web de Schneider Electric à l’adresse suivante : www.schneider-electric.com.

2 Cliquez sur Produits et Services, puis sur Automatismes et Contrôle.

3 Dans la section Downloads (Téléchargements) située dans la barre de menu à gauche, cliquez sur 
Current offers (Offres actuelles).

4  Dans la liste déroulante Choose a function (Choisir une fonction), sélectionnez Motor Control 
(Commande moteur).

 Dans la liste déroulante Choose a range (Choisir une gamme), sélectionnez TeSys U.
 Dans la liste déroulante Choose a type of document (Choisir un type de document), sélectionnez 

Software/Firmware (Logiciels/Micrologiciels).

Cliquez sur >Find (Rechercher).

5 Sélectionnez Communication Module TeSys U PROFIBUS LULC07 (Module de communication 
TeSys U PROFIBUS LULC07) et téléchargez le fichier LULC07_GSD_DIB_files_V100.exe.

6 Double-cliquez sur LULC07_GSD_DIB_files_V100.exe sur votre disque dur. Cliquez sur Accept 
(Accepter) dans la fenêtre "Licence for software downloaded from Schneider-Electric web sites" 
(Licence du logiciel téléchargé sur les sites Schneider-Electric) qui s'ouvre puis naviguez jusqu'au fichier 
de destination et cliquez sur Install (Installer).

7 Sélectionnez le fichier GSD : TELE094C.GSD
12 1672606 06/2009



Configuration d'un réseau de communication vers un automate
2) Configuration du réseau d'application

Les premières étapes de configuration avec le logiciel Unity Pro XL sont décrites ci-dessous :

 

Étape Action

1 Démarrez le logiciel Unity Pro XL V4.0.

2 Configurez votre automate Premium et les accessoires de communication (carte PCMCIA, etc.) :

3 Enregistrez votre application comme un fichier .STU.

4 Double-cliquez sur le coupleur TSX PBY 100 . La fenêtre Configuration du MODULE PROFIBUS-DP 
s'ouvre : 

Il est inutile de l'éditer. 
Pour poursuivre le processus de configuration, cliquez sur le bouton Sycon (Hilscher). S'il n'est pas 
affiché, installez à nouveau le logiciel Sycon.
1672606 06/2009 13



Configuration d'un réseau de communication vers un automate
Poursuivez le processus de configuration avec le logiciel Sycon, comme décrit ci-dessous :

Étape Action

1 Dans le logiciel Sycon V2.9, cliquez sur File → New (Fichier - Nouveau).

2 Dans la boîte de dialogue Select fieldbus , choisissez Profibus DP et validez.

3 Importez votre fichier GSD LULC07 en cliquant sur File → Copy GSD (Fichier - Copier GDS).

4 Recherchez le fichier TELE094C.GSD .

5 Insérer un maître : 
 cliquez sur Insert → Master... (Insérer - Maître...) ou

 sélectionnez .

6 Double-cliquez sur le menu Setting (Réglage) et sélectionnez Master Configuration (Configuration du 
maître) : la case Auto addressing (Adressage automatique) est cochée par défaut. Cela signifie que 
vous n'aurez pas à modifier les adresses d'entrée et de sortie des nœuds 1 et 2. Si vous désélectionnez 
cette case, vous devrez modifier les adresses des nœuds.
 
Dans la fenêtre Insert Master (Insérer maître), sélectionnez le TSX PBY 100 dans la liste Available 
masters (Maîtres disponibles). Cliquez sur le bouton Add>> (Ajouter). Entrez une adresse dans le 
champ Station address (Adresse de station), par exemple 10. 

Confirmez en cliquant sur OK.

7 Insérer nœud : 
 cliquez sur Insert → Slave... (Insérer - Esclave...) ou

 sélectionnez .

8 Dans la fenêtre Insert Slave (Insérer esclave), sélectionnez le LULC07 - TeSys U Profibus dans la 
liste Available slaves (Esclaves disponibles). 

L'esclave 1 se trouve à l'adresse 1. L'esclave 2 se trouve à l'adresse 2. 
14 1672606 06/2009



Configuration d'un réseau de communication vers un automate
9 Pour définir le paramètre de bus, sélectionnez le maître à l'écran et cliquez sur Settings → Bus 
Parameter (Réglages - Paramètre du bus) :

Définissez le champ Baudrate (Débit en bauds) sur 1500 kBits/s et confirmez en cliquant sur OK.

10 Double-cliquez sur un nœud pour ouvrir la fenêtre Slave Configuration (Configuration de l'esclave).

Dans la liste Module, sélectionnez :
 Sc_St_R_MS pour Slave1 (Esclave 1).
 Sc_Ad_R_MS pour Slave2 (Esclave 2).

où les abréviations signifient... 
 Sc : Starter-controller (démarreur-contrôleur), 
 St : Standard control unit (unité de contrôle standard) et Ad : Advanced control unit (unité de 

contrôle avancée),
 R : Remote control (contrôle à distance),
 MS : Motor Starter (démarreur).

NOTE : Pour passer de l'esclave 1 à l'esclave 2, vous pouvez le faire à partir de cette fenêtre en 
changeant les esclaves dans la zone Actual slave (Esclave actuel) ou vous pouvez accéder à 
l'arborescence et double-cliquer sur Slave2 (Esclave 2). 

Étape Action
1672606 06/2009 15



Configuration d'un réseau de communication vers un automate
11 Pour définir une stratégie de repli en cas de perte de communication, cliquez sur le bouton 
Parameter Data (Données du paramètre). Dans la fenêtre Parameter Data (Données du paramètre), 
cliquez sur le bouton Module.
Sélectionnez la première ligne de la liste et définissez la stratégie de repli en cas de perte de 
communication dans la liste déroulante : 

 Freeze outputs (Bloquer les sorties) pour l'esclave 1
 Force stop (Forcer l'arrêt) pour l'esclave 2

Confirmez en cliquant sur OK.

12 Sauvegardez votre configuration en cliquant sur File → Save as (Fichier - Enregistrer sous). Votre fichier 
de configuration présentera une extension .PB. 
Convertissez votre fichier au format ASCII en cliquant sur File → Export → ASCII (Fichier - Exporter - 
ASCII), pour l'utiliser dans Unity Pro.
Quittez le logiciel Sycon.

Étape Action
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Configuration d'un réseau de communication vers un automate
Terminez le processus de configuration avec le logiciel Unity Pro XL, dans la fenêtre Configuration du 
MODULE PROFIBUS-DP : 

Étape Action

1 NOTE : Dans la fenêtre Configuration, (1), (2) et (3) correspondent aux actions à réaliser lors des 
étapes 1, 2 et 3.

Cliquez sur le bouton Load CNF  (Charger CNF) et ouvrez le fichier .CNF.

2 Modifiez l'option Diagnostic Length (Longueur de diagnostic) par défaut, en fonction des informations 
de télégramme de diagnostic pour Profibus DP figurant dans le manuel d'utilisation TeSys U LULC07 
Profibus DP :
 Valeur par défaut (en octets) = 32
 Nouvelle valeur = 36

3 Pour optimiser la taille de la mémoire, définissez l'option No. of IW/QW (Nombre d'IW/QW) dans la liste 
déroulante :
 Valeur par défaut = 128
 Nouvelle valeur = 32

4
Sélectionnez Edit → Validate (Editer - Valider) ou cliquez sur  pour valider la configuration. 

5 Sélectionnez Build → Rebuild all project (Créer - Recréer tout le projet).
1672606 06/2009 17



Configuration d'un réseau de communication vers un automate
3)  Exécution d'un test fonctionnel du réseau de communication, notamment les produits et l'automate Premium 

Étape Action

1 Branchez le câble de programmation approprié de votre ordinateur à l'automate Premium.

2 Mettez l'automate Premium sous tension.

3 Cliquez sur Connect (Connecter).

4 Depuis le menu PLC (Automate), transférez le projet.

5 Allumez les 2 systèmes TeSys U et cliquez sur Run (Exécuter). 
A ce stade, la communication est correctement établie : la DEL d'état des communications rouge BF est 
éteinte et la DEL 24V verte est allumée. Cependant, si la DEL de défaut ERR clignote, cela signifie que 
la communication a été perdue.

6 La fenêtre PROFIBUS-DP MODULE (Module PROFIBUS-DP) présente un onglet Debug (Mise au 
point). Les tableaux ci-dessous sont extraits de cet onglet, avec les adresses contenant les échanges 
cycliques par équipement. Nommez les variables de façon à fournir des informations relatives à 
l'emplacement de la mémoire (par ex. Ready_M1 au lieu de %IW0.3.0).

En cas de défaut de communication au niveau d'un esclave, la ligne correspondante de la liste 
PROFIBUS-DP slave configuration (Configuration esclave PROFIBUS-DP) apparaît en rouge et un 
message d'explication s'affiche dans la zone de diagnostic PROFIBUS-DP.
Les échanges cycliques de données apparaissent dans la colonne Value (Valeur).
18 1672606 06/2009



Configuration d'un réseau de communication vers un automate
3.2. Configuration des DFB avec l'application

Présentation

Les DFB (Derived Function Blocks - Blocs fonction dérivés) TeSys ont été développés pour faciliter et 
optimiser l'intégration des démarreurs-contrôleurs TeSys U dans les applications d'automate.

Le DFB Ctrl_pfb_u_ms est destiné au contrôle et à la commande d'un seul démarreur-contrôleur 
TeSys U TeSys U (jusqu'à 32 A/15 kW ou 20 hp) via le réseau Profibus DP MS (Motor Starter).

1. Téléchargement des fichiers DFB
2. Installation du DFB dans Unity Pro
3. Extraction de votre projet et de l'application DFB dans Unity Pro

Pour de plus amples informations, reportez-vous au manuel d'utilisation des DFB TeSys :

1) Téléchargement des fichiers DFB

Le tableau suivant présente la procédure de téléchargement des TeSys DFB à partir du site Web 
www.schneider-electric.com :

2) Installation du DFB dans Unity Pro

Étape Action

1 Accédez au site Web de Schneider Electric à l’adresse suivante : www.schneider-electric.com

2 Cliquez sur Produits et Services, puis sur Automatismes et Contrôle.

3 Dans la section Downloads (Téléchargements) située dans la barre de menu à gauche, cliquez sur 
Current offers (Offres actuelles).

4  Dans la liste déroulante Choose a function (Choisir une fonction), sélectionnez Motor Control 
(Commande moteur).

 Dans la liste déroulante Choose a range (Choisir une gamme), sélectionnez TeSys U.
 Dans la liste déroulante Choose a type of document (Choisir un type de document), sélectionnez 

Software/Firmware (Logiciels/Micrologiciels).

Cliquez sur >Find (Rechercher).

5 Sélectionnez TeSys DFB offer package (ensemble DFB TeSys) et téléchargez le fichier zippé sur votre 
disque dur.

6 Importez le fichier TeSys DFB offer package.zip vers un répertoire unique sur votre disque dur. 
2 répertoires, PL7 et Unity Pro, seront créés, chacun contenant les dossier suivants :

Étape Action

1
A partir du menu  Démarrer, Tous les programmes, naviguez jusqu'à Schneider Electric → Unity 
Pro → Types Library Update (Mise à jour bibliothèque de types).

2 Dans la fenêtre Types Library Update, naviguez jusqu'à 04 Cyclic control command → FAMILY.DSC 
(Contrôle commande cyclique 04 - Famille.dsc) et ouvrez cet élément. 
NOTE : La version d'application que vous sélectionnez doit être compatible avec Unity Pro.

3 Cliquez sur Install family (Installer famille). Une fenêtre pop-up s'ouvre avec le message suivant : 
"Installation réussie". Puis quittez.
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3) Extraction de votre projet et de l'application DFB dans Unity Pro

Étape Action

1 Démarrez le logiciel Unity Pro.

2 Ouvrez la section FBD d'un programme. A partir du menu Edit (Edition), accédez au sous-menu Data 
Selection... (Sélection de données...). 
Une fenêtre Function Input Assistant (Assistant d'entrée de fonction) vide s'ouvre. Le premier élément 
est FFB type (Type de FFB). Naviguez jusqu'à Profibus DFB : Ctrl_pfb_u_ms. La fenêtre suivante 
s'ouvre :

Confirmez en cliquant sur OK.

3 La fenêtre Function Input Assistant (Assistant d'entrée de fonction) contient à présent votre sélection :

Confirmez en cliquant sur OK.

4 La représentation graphique DFB s'affiche :
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Caractéristiques d'entrées

Le tableau suivant décrit les entrées des DFB ainsi que leur disponibilité selon l'unité de contrôle :

Caractéristiques de sorties

Le tableau suivant décrit les sorties des DFB ainsi que leur disponibilité selon l'unité de contrôle :

Entrée Type Plage Valeur par 
défaut

Description LUCA LUCD

Ms_in1 INT _ 0 Association au premier mot des données 
cycliques d'entrée relatives à l'esclave

√ √

Run_fwd EBOOL 0...1 0 Commande de marche directe du moteur √ √

Run_rev EBOOL 0...1 0 Commande de marche inverse du moteur √ √

Rst_flt EBOOL 0...1 0 Réinitialisation (en cas de défaut interne du 
module de communication, réinitialise le module 
de communication aux paramètres d'usine).

√ √

Rst_warn EBOOL 0...1 0 Alarme de réarmement (par exemple, perte de 
communication)

√ √

Em_strt EBOOL 0...1 0 Démarrage d'urgence (réinitialisation de la 
mémoire thermique)

  

Trip_tst EBOOL 0...1 0 Test de déclenchement de surintensité via le bus 
de communication

  

Sortie Type Plage Valeur par 
défaut

Description LUCA LUCD

Ms_out1 INT _ 0 Association au premier mot des données 
cycliques de sortie relatives à l'esclave

√ √

Ready EBOOL 0...1 0 Système disponible<:hs>: la poignée rotative est 
tournée en position On et aucun défaut n'est 
détecté

√ √

Closed EBOOL 0...1 0 Etat du pôle : fermé √ √

Tripped EBOOL 0...1 0 Système déclenché : la poignée rotative est 
tournée en position Trip

√ √

Fault EBOOL 0...1 0 Tous les défauts √ √

Alarm EBOOL 0...1 0 Toutes les alarmes √ √

Rst_auth EBOOL 0...1 0 Réinitialisation du défaut autorisée  √

Starting EBOOL 0...1 0 Démarrage en cours :
1 = le courant croissant est supérieur à 10 % FLA
0 = le courant décroissant est inférieur à 150 % 
FLA

 √

Running EBOOL 0...1 0 Moteur en marche avec détection d'un courant, si 
supérieur à 10 % de FLA

 √

Avg_curr INT 0...200 0 Courant moteur moyen (% FLA)  √
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Configuration d'un réseau de communication vers un automate
Programmation DFB (= M1) pour le moteur 1

Programmation DFB (= M2) pour le moteur 2

Étape Action

1 Associez l'entrée Run_fwd à la condition de démarrage du moteur 1.

2 Associez les sorties M1 aux variables d'automate pour l'utilisation dans le programme :
 Sortie M1 fermée = position du contacteur KM1
 Sortie M1 déclenchée = position déclenchée du Q1 TeSys U

3 Vérifiez que le M1 pour le moteur 1 s'affiche comme suit :

1 Non applicable
2 Applicable mais non utilisé, peut être géré par l’application de l’automate.

Etape Action

1 Associez l'entrée Run_fwd M2 à la condition de démarrage du moteur 2.

2 Associez les sorties M2 aux variables d'automate pour l'utilisation dans le programme :
 Sortie M2 fermée = position du contacteur KM2
 Sortie M2 déclenchée = position déclenchée du Q2 TeSys U

3 Associez la sortie Avg_curr M2 à un registre d'automate pour utiliser le courant moyen du moteur 2 dans 
le programme.

4 Vérifiez que le M2 pour le moteur 2 s'affiche comme suit :

1 Non applicable
2 Applicable mais non utilisé, peut être géré par l’application de l’automate.
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